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Viewfinder cover photo taken by. 

EASY Resizing Photoshop Trick! 

[Hidden Crop Feature] 

 

In this 90-second Photoshop Tip, I’m going to show you how to easily crop and resize an image.  

We will use a little-known feature within the Crop Tool called "Front Image" to take the dimen-
sions and resolution of one image and apply it to another. 
 

  Watch Here: https://www.youtube.com/watch?v=9TXClL_yJfI 

 

 

How To Blur Backgrounds In Photoshop 

Complete Step-By-Step Guide 

 

In this tutorial, you will learn how to easily create the shallow depth of field effect (out of focus 
background) without an expensive lens.  

This easy step-by-step guide will teach you about selections, Layer Masks, Smart Objects, and 
the Blur Gallery to create a highly realistic blurry background effect. 

I hope that you find this tutorial helpful! 
 

  Watch Here: https://www.youtube.com/watch?v=mPp7h5ddQ3E 

 

 
 

http://www.viewbug.com/
http://www.ephotozine.com/
http://www.photographynsw.org.au/
http://www.a-p-s.org.au/
https://gurushots.com/
http://photoserge.com/free-lessons/all
https://www.youtube.com/watch?v=9TXClL_yJfI
https://www.youtube.com/watch?v=mPp7h5ddQ3E
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Contrast and Temperature in Color Photography 
by Autumn Lockwood 
 
Although black and white photography has been the standard for beginning film photography students for a 
long time, at some point every photographer should learn the basics of color photography. Learning color 
photography requires a firm understanding of the basic elements of photography, which can be broken 

down into the following easy to understand elements. 
 
“Baseball” captured by Hector Rodriguez 
It Starts with Contrast 
In black and white photography, contrast refers to the dif-
ference between the lightest and darkest elements of a 
photograph. In essence, you can think of contrast as “how 
white is white?” With black and white photography, there 
are really only three tones: low contrast, medium, and 
high contrast but with color photography it gets a little 
more complicated. Color photography has color contrast 
compared to the tonal contrast of black and white. 
Color contrast is determined by the way each of the colors 
interact with the colors surrounding it. While the contrast 
can still be adjusted to push the bright to dark ratio, the 

colors in a photograph appear different depending on what’s around them. For instance, think of a baseball 
sitting in bright green grass—that image has high color contrast because the bright white of the baseball 
stands out against the cool green of the grass. 
Color Temperature 
Any time you’re taking pictures in color, you have to pay attention to the temperature of the colors. Differ-
ent lights result in different color temperatures, in the same way that the sun looks different at various 
times of day. Although there are lots of technical measurements of color temperature, the simplest way to 
think of it is in terms of tint. 
Tint and color temperature are actually referred to as “white balance” in photography. Film and sensors are 
developed with a certain kind of light in mind, and any time photos are shot in different lighting circum-
stances it affects whether or not white looks truly “white.” For example, if you take a picture underneath a 
fluorescent light, it always has a green tint to it because that’s the color temperature of those lights. 

 
“Playing with white balance” captured by Tom Check 
Using Temperature 
Any time you shoot, you want to understand which tint or color temperature is best for your picture. Red-
dish, warm tints such, as those provided by a sunset are flattering to most human skin tones, while cooler, 
bluish tints are best for neutral product photography. 

You can adjust your white balance several dif-
ferent ways; you can do it with your camera, 
filters, or photo editing software. Similar to 
aperture and shutter speed, if you’re not shoot-
ing in RAW, it’s usually a good idea to take a 
photograph several times with different white 
balance settings to give yourself the most flexi-
bility after the shoot is over. 
 
“Color: San Francisco Sunrise in Blue” cap-
tured by Eugene Kim 
Learning how to master colors is a skill that 

https://www.picturecorrect.com/authors/autumn-lockwood/
https://www.flickr.com/photos/nerolives/
https://www.flickr.com/photos/tombothetominator/
https://www.flickr.com/photos/eekim/
https://www.flickr.com/photos/tombothetominator/2689943520
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takes lots of practice. Designers often take several courses on color as part of their education, and there is 
no shortage of competing opinions on how color can be used best to achieve certain goals. 
If you’re just starting off learning to use color, then your first goal is to accurately capture the image the 
way you see it. Once you can do this reliably with color photography, you can start working to manipulate 
these colors to add to the narrative of your photographs. And as usual, find what works works best for you 
and have fun doing it. 
 
 

How to Photograph the Moon for Stunning Results 
 
The beauty of moon photography is that it is pretty easy to get a good shot. Of course, that’s if you’re not 
looking to capture extreme close-ups. 
With standard equipment, you can capture moon shots from your house, garden, or even the city centre. 
The easiest way to take pictures of the Moon is to include it in a nocturnal landscape or cityscape. While 
you will not get to see great details in the moon itself, it will improve your image in several ways by: 

  adding a point of interest in the sky; 

  helping to balance the composition; 

  setting a mood for the scene; 

   adding light to the landscape. 

You can also photograph natural landscapes using light from a full moon. 
The real treat is to get up close and personal. 
To get a shot of the moon like the one below, you’ll need a telephoto lens. An option with a focal length 

between 100 to 300mm is enough to get the moon look as 
big as this. 
The moon in its first quarter. It is yellow because of its low 
altitude. 

How to Focus on the Moon to Get 
Sharp Images 
If you want to get sharp moon photos, your focus needs to 
be precise. Unfortunately, chances are the autofocus will 
have difficulty when it’s so dark. So, switch to manual fo-
cus. 
Do not trust the infinite mark on your lens or the hard stop 
of the focusing ring because it’s not reliable. Although it 
comes standard on all lenses, its position is often inaccu-
rate. 

In reality, the infinity zone sits somewhere between your lens’s infinity mark and the maximum focal 
length mark. 
So instead of using the infinity mark, use all the advanced functions your camera has to help you focus on 
the moon. Features such as Live View, Magnification, and Focus Peaking will all help. 
With the camera on a tripod, frame an area on the moon with contrasted craters. Now, try to get their ridges 
as sharp as you can by focusing back and forth until you find the sweet spot. Achieving good focus can 
take time. 
If you can, use a white marker to mark true infinite on your lens. Doing so will speed up your future photo-
graphic sessions. 
 

How to Compose Your Moon Shots 
Even if you get the technical aspects of photographing the moon, your images won’t be as impactful if your 
composition is off. 
But thankfully, your camera has a few tools to help you achieve the perfect composition. 
The first feature you can use is the horizon or spirit level. It isn’t a composition tool per se, but it helps you 
ensure your camera isn’t crooked when taking pictures. This feature is especially important when capturing 
night landscapes. But in most cases, it’s not necessary for moon close-ups. 
Now for the composition part, you’ll need to turn on your grid. Using the Rule of Thirds, place the moon 

https://expertphotography.com/the-ultimate-guide-to-landscape-photography-at-night/
https://expertphotography.com/cityscape-photography-tips/
https://expertphotography.com/the-ultimate-guide-to-landscape-photography-at-night/
https://expertphotography.com/manual-focus/
https://expertphotography.com/manual-focus/
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and other crucial elements anywhere the lines intersect. Doing so ensures your image looks balanced and 
pleasing to the eyes. 
Every camera has a spirit level and a grid. But activating them may vary depending on the manufacturer 
and the model you have. Consult your manual to turn on these features on your device. 

How to Read The Sky 
Standing between you and the moon is the Earth’s atmosphere. Clouds, haze, air turbulence, pollution, 
dust, and humidity – all of these will degrade your image. 
Try to take pictures of the moon when it is high in the sky. This way, less of the atmosphere will be in-
between. Clear winter nights are your best bet for excellent visibility. 
But be careful. If you’re photographing the moon from a city during the winter, avoid taking photos when 
the moon is low. The escaping heat from the roofs will create turbulence that will further degrade your 
view. 
For the same reason, if you want to photograph the moon from inside your house, shoot through the win-
dow. If you open it, the thermal gradient between the air inside and that outside will create turbulence. 
 
For best results, it also helps to go to a location with minimal light pollution. That way, you get the sharp-
est images of the moon. Of course, considering you also meet all the other conditions we mentioned above. 

 
How to Include Landscape in your Moon Photos 
Taking pictures of both the landscape and the moon can be tricky. Especially since each one requires spe-
cific exposure settings. For the most part, moon pictures need a fast shutter speed while longer exposures 
are essential or nightscapes (a.k.a. night landscapes). 
So it’s not surprising that there are plenty of ways to take pictures of scenes with the moon in the same 
shot. And each method produces a distinct effect. 
The simplest way is to photograph both the moon and the nightscape is by using long exposure. The slow 
shutter speed lets in enough light to properly expose the landscape. 
In this case, the moon will be overexposed, which would otherwise be bad news. But sometimes, it creates 
a beautiful hazy effect that adds mood to your pictures. This method works even better if clouds are block-
ing the moonbeam. 
But what if you want to expose both the landscape and the moon in one shot? Then you can try boosting 
your ISO. These days, some cameras let you work between 3000 to 6000 ISO or more without introducing 
distracting image noise. With such high sensitivity, you can take pictures of anything with relatively fast 
shutter speed. 
The only downside is that even with minimal image noise, high ISO could still drastically reduce the image 
quality. So use this method with caution and only apply it only if you find it necessary. 
The best way to expose for the landscape and the moon separately. In other words, take two photos with 
different exposure times and combine them in Photoshop. Mask in the moon into your nightscape, and you 
got yourself the perfect image. 

 
How to Take Moon Photos with your Smartphone 
You must be wondering, why can’t I take a picture of the moon with my iPhone? Well, your smartphone’s 
built-in lens doesn’t have enough magnification to capture moon pictures. 
But that doesn’t necessarily mean you can’t take photos of the moon. All you need are a few accessories to 
create impressive results. 
 

Essential Equipment 
The first essential tool is a telescope, which would act as your telephoto lens. Although any telescope 
would work, it would be best to pick an option that produces excellent detail and has minimal distortion. 
The best telescope should have at least 25x magnification. It also needs to have an aperture of 70mm or 
more. Take note that the aperture value on these devices is different from cameras that use f-stops as the 
standard. 
Next, you’ll need a phone telescope adapter which you attach your mobile device to the eyepiece of the 
scope. Buy one that is universal so you can easily connect it to any telescope you have. 
The last piece of equipment you’ll need is a phone app. Consider uploading either ProCam or Camera + 2 
to let you change your camera settings manually. These programs are essential, especially since you need 
to use fast shutter speed to capture moon images. 

https://expertphotography.com/cloud-photography/
https://expertphotography.com/winter-landscapes/
https://expertphotography.com/the-ultimate-guide-to-landscape-photography-at-night/
https://expertphotography.com/understand-iso-4-simple-steps/
https://amzn.to/35ZXl2C
https://apps.apple.com/us/app/procam-7/id730712409
https://apps.apple.com/us/app/camera-2/id1313580627
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The Process 
Before photographing the moon, you’ll need to attach your adapter and your phone to the telescope first. 
The adapter is essentially a mount that holds your device in place. When installing, make sure you align 
the eyepiece and the lens. Otherwise, you may end up with vignettes that obstruct the moon. 
Now turn on your camera app and change your settings the way you would on a regular camera. To 
achieve focus, tap the screen and wait for the lens to adjust. Take some test shots to make sure the expo-
sure is correct. 
Once you’re satisfied with your settings, compose your shot and take a picture! 
 
Feel free to edit your moon images using Lightroom, VSCO, or similar mobile editing platforms. 

How to Use Cropping For Moon Closeups 
The size of the moon in your photo mainly depends on the focal length of the telephoto you use. The long-
er it is, the better close-ups you get. 
The downside is that most of us don’t have an expensive 800mm lens. And that means that super close-ups 
of the moon are going to be challenging to achieve. 
But one trick you can try to create a super close-up is by cropping. Doing so gets rid of the unnecessary 
parts and enlarges the size of the moon in your photo. 
Just be careful not to crop too much, or you’ll end up with a low-quality image. To make sure your image 
has enough resolution, zoom in, and check the size of the pixels. 
If the moon looks blurry and you can see the grain, then that means you cropped too much. So readjust 
everything until you see the details return. 
You can do this technique using pictures from any camera. But if your device has a crop sensor, then con-
sider cropping minimally. Why? Because the photos a crop sensor produces are small and lack the resolu-
tion that full-frame sensors have. 
But even if you have a full-frame sensor, cropping too much can still affect the image quality. So use your 
judgment wisely when using this technique. 
 

How to Photograph the Moon During Different Phases 
Every month or so, the moon goes through a series of lunar phases. These go from New Moon (not visible 
in the sky) to Waning Moon. The moon changes by age (in days) and illumination. 
During the year, the moon is visible at different times of the day. For more information, look at a lunar cal-
endar. Or check the weather forecasts to know when it rises, sets, and its phase. 
Each lunar phase affects the moon’s shape and the number of visible details. 

 
New Moon 
If you shoot near the New Moon, very little of the lunar surface is visible. The moon will appear as a thin 
arch in the sky. 
I like this phase because you can get moody moon photos. You can also easily see that the lunar surface in 
the shadow is visible, although faint. This effect is due to the reflected light from Earth’s atmosphere 
called the Earthshine. 
 

Waxing and Waning Moon 
In these phases, the light on the moon is mostly coming from the side. Between the New and Full Moon, 
the illumination increases during the Waxing period. 
Between the Full and New Moon, the illumination decreases during the Waning phase. 

https://apps.apple.com/us/app/adobe-lightroom-for-ipad/id804177739
https://apps.apple.com/us/app/vsco-photo-video-editor/id588013838
https://en.wikipedia.org/wiki/Lunar_phase
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Near the line separating the dark and bright 
areas of the moon (terminator), you have the maximum contrast. This area is also the most detailed region 
of the lunar surface. 
Use the terminator region to help you achieve a good focus on shooting the moon. 

 
 
The Full Moon 
During the full moon, the light is frontal. No shadows are present on the surface to enhance its morphology. 
The contrast across the Moon is rather flat, but overall it is still an impressive sight. 
A Super Moon is a Full Moon when it’s at its closest distance to Earth in its elliptical orbit. A Super Moon 
looks 14% larger in the night sky and 7% brighter than a normal one. 
At the farthest distance from Earth, we have a rather unimpressive Micro Moon. 
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I bet you forgot that we 
have a web site @ 

http://www.daptocameraclub.org.au/ 

http://www.daptocameraclub.org.au/
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4 Tips for Shooting Drop Dead Gorgeous Waterfalls 
 
A Post By: Eric Leslie  
 
Waterfalls are a very popular subject for landscape photographers. The draw to their natural beauty is 
clear, but sometimes coming home with the best shots is harder than you might think. As the curator for the 
Google+ Photography theme, #WaterfallWednesday I get asked how to take better pictures of waterfalls 
every week. So let me share some tips with you. 

 
1. Your gear is good enough 
The first thing most people suggest you need in order to shoot waterfalls is a complete quiver of neutral 
density (ND) filters to get a long exposure. Forget that! Let’s start with a camera that can shoot on manual 
and a tripod. That’s all you need. The biggest problem with slapping a dark ND filter on your lens is still 
the sun. When it’s bright overhead, you have bright “hot spots” and dark shadows that don’t look great. 
The light is harsh and flat. The best thing to do is show up at sunrise and sunset. Waterfalls are often in 
deep canyons, so as long as the sun is behind the mountains with the whole waterfall in the shade, you can 
achieve a long exposure with nice even light. In fact, you can plan ahead to maximize this. If you think 
about it, if the waterfall you’re wanting to shoot is facing east, sunrise would not be the best time of day 
because it will catch the light right on the falls. So an east facing waterfall will be best shot in the late after-
noon. 

https://digital-photography-school.com/author/ericleslie/
https://plus.google.com/s/%23WaterfallWednesday
https://digital-photography-school.com/wp-content/uploads/2012/05/20110426-Glaring-Omission-Crystal-Creek-Falls.jpg
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2. Read the waterfall 
How long does the exposure actually need to be? I think the answer varies like people’s taste in fast food. 
Personally I categorize waterfalls into two different categories. There are the falls that rage with so much 
water they take your breath away. The others are dainty and delicate. So keeping in mind I don’t want the 
waterfall to be a detail-less blob of white water, you need to set the exposure appropriately. 

 
This waterfall was very full and the light was low. At 1.6 seconds, I let this exposure go too long leaving 
the water without details. 
  
On Manual, I usually start with the slowest ISO my camera can go, 100. Then I set my aperture small 
enough to maximize focus, usually around f/8 to f/10. Then I see what kinds of shutter speeds that nets. 
For the big falls, I try to keep my exposure under a second. Anything between ¼ to a full second will show 
the water’s motion and still retain all the detail in that movement. 
Small stringy waterfalls just love putting on a show with longer exposures. These shots look great when 
you can go as long as possible. Don’t be afraid of the small aperture police who say you will lose sharp-
ness. Photography is always about compromises and in this case, the slightest loss in sharpness only visi-
ble when viewed at 200% is greatly outweighed by capturing the water’s movement. Don’t be afraid to use 
f/22 if you need it. I try to shoot for exposures 1-4 seconds long at these kinds of waterfalls. 
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3. Save the Trees 
Have you ever tried to shoot a waterfall with a long exposure and noticed that the leaves on the trees and 
plants move with just the slightest breeze? You’ve probably seen people take a bracket of a landscape to 
compress the dynamic range of light into a single image. We can do the same thing here, only we’re com-
pressing time. After you’ve bagged your shot of the waterfall, look around the edges of the photograph and 
you see if the plants are soft and fuzzy. If they are, you have to play this mental gymnastics to switch into a 
sports mindset of shooting to freeze motion. You need something in the 1/100 or faster range. You can 
open up the aperture, but make sure you don’t loose your maximum focus. If that’s not enough light, you 
need to start boosting your ISO until you can achieve that shutter speed. 
Back home, you take the two exposures and blend them back together using layer masks in Photoshop. I’ll 
save that topic for another blog post. 
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I blended two shots together to keep the leaves sharp because they were moving in the breeze. 
4. Head out when it’s cloudy 
One way you can buy yourself some more camera time is to hike on overcast rainy days. You get all the 
benefits of shooting when the sun is low, with the freedom to shoot all day. I also find you get much better 
color when it’s overcast so things like mossy rocks or autumn leaves really pop. 
One pitfall you need to avoid on cloudy days is including the sky. Depending on the waterfall, if you can 
get up high to shoot down on the falls, eliminating the sky from the shot, you will avoid getting a boring 
grey sky over your waterfall. 

 
On this overcast day, I choose to get in close and focus on the details to exclude the sky from the shot. 
Like anything in photography, it takes practice and experimentation. Get out there and put some of these 
tips to practice. 
 
 
 
 

An Introduction to External Flash Units 
A Post By: Darren Rowse 

In this post Tom Pickett (from www.tpickettphotography.com) responds to some of the questions we’ve had lately 
here at DPS on using External Flash Units. His post was so long 
and detailed that I thought I’d break it down into two posts. Stay 
tuned for a follow up one tomorrow. 

It never ceases to amaze me. The camera manufacturers have a 
remarkable staff of engineers and those engineers, based on input or 
suggestions from actual users throughout the world continue to de-
velop some amazing gear. 

The equipment continues to help us produce outstanding images and 
it makes our jobs easier, makes us better or both. 

One of the areas of remarkable and accelerated achievement is in 
external hot-shoe mounted flash units. Yet, as a professional photog-
rapher for 23 years, I can still admit to using at times a MANUAL 
electronic strobe. More on that later. 

One of the most requested subjects at DPS is about “hot-shoe” flash 
units. After reading the questions, I can see that there is quite an ar-
ray of inquiries on how to use these units correctly to achieve the 
desired results. One query even asked about high speed sync on 
flash units. This is rarely asked about and I was surprised there was 
interest in that area since I am personally a user of high-speed sync 
quite often in my work. 

This article will focus on the dedicated flash units by the prima-
ry manufacturers such as Canon. 

https://digital-photography-school.com/author/darren/
http://www.tpickettphotography.com
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Most of the latest units are given the acronym E-TTL which means “Evaluative-Through-The-Lens” operation. There 
are several other ways to use these newest flashes including manual operation where you decide how much flash it 
should put out. Even 3rd party companies such as Sigma and Metz make E-TTL flash units that are specific to Can-
on, Nikon and other name brands. 

Before we start, I apologize to those of you that do not have a DSLR as this article is written with those people in 
mind. Those of you who have any one of the many fine point-and-shoot digital cameras will be covered in the future 
on how best to use your built in flash units. 

A Common Misconception about Flash Output 
The first thing that needs to be addressed is the very common misconception flash output is determined by the how 
bright the flash gets when you fire a unit. That is not correct. Flash output is determined by the amount of time or du-
ration the flash unit emits light from the strobe unit. So what determines the duration of the flash? That is a complicat-
ed algorithm but in simple terms, it is the combination of your aperture, shutter speed and amount of light needed as 
determined by your camera. 

If it is being used outdoors as a fill light, the duration is measured in milliseconds. If it is being used in very dark con-
ditions, the duration will still be in milliseconds but much longer than fill light. So, let us make sure you understand 
this… the amount of brightness a flash unit puts out stays constant. What determines you getting the correct expo-
sure is the duration of that flash. 

A Word of Caution About Using Flash Units 
Now is a good time as well to mention to use caution at all times using flash units. Do not ever place the unit close to 
you or any person look directly at the business end of the unit and fire the flash. The light is very intense and will 
wreak havoc on your eyesight for a while. Point it away from you when testing it at all times. Also, the voltage inside 
a charged speedlight is extremely high and dangerous. Do not curiously open a unit to see how it works. 

How External Flash Units Work 
The latest offerings of flash units that mount on your hot-shoe are ingenious devices. They are as automatic as one 
would ever think could be developed. In fact, if you are accustomed to point and shoot cameras, using one of these 
flashes on your hot-shoe is as easy as pushing shutter release. What happens is an amazing technological achieve-
ment. When you have the unit turned on to take a photo and press the shutter release, the flash puts out a pre-flash 
to the subject you are focused on and sends that information back to the camera. The camera processes the pre-
flash data then fires again to take the picture. Mind you, the subjects are totally unaware that there were two flashes 
firing in their eyes, a pre-flash and then the main flash. All this happens in what is measured not in milliseconds, but 
in microseconds! 

In the pre-flash, the flash unit and camera are working together to determine the ambient light, measured by the sen-
sor in the camera. The sensor compares the ambient light values with the light reflected by the subject. Canon’s E-
TTL II even measures the distance to the main subject and that also becomes part of the evaluation taking place. 
The pre-flash determines how much flash duration will be needed, sends that information to the camera and you are 
the recipient of a perfectly exposed subject and background. I have purposely typed the last three words boldly 
since we will talk about that later. 

Camera Settings and Different Kinds of Flash Photos 
Now let us examine the setting on the camera and how that determines what kind of flash photo you will receive. 
Every modern DSLR has the following settings on the camera: there is “P”, then “TV”, “AV” and “M” on every camera 
that I am aware of. Yes, then there are the totally auto modes on the same control….those icons that mean portrait, 
landscape, close-up, sports and night portrait. For now, I really want everyone to focus on pretending those do not 
exist so that we can study the use of the P, TV, AV and M modes. These are the modes that once you learn how to 
use them, you will rarely go back to the “auto modes”. 

The “P” mode is in reality a semi auto mode, that is the P is the first in the line of programmed modes, but in practical 
use, the camera still continues to do auto exposure. That is what Canon calls Program AE. There is a huge differ-
ence in the P mode as compared to the “fully automatic” mode indicated by a rectangle usually colored green on the 
camera. In P mode, you will be allowed to change shutter speeds. In the fully automatic mode, you cannot change 
anything. 

Try it. Set your camera to P mode, and then point it at a subject in some nice daylight. Notice that perhaps your cam-
era will select, on its own, a shutter speed of 1/125 with an aperture of F11. Then using the wheel selector of top of 
the camera, you can actually change the shutter speed to 1/250, 1/500 etc but at the same time as you change to 
faster shutter speeds your camera will open the lens up accordingly to allow the same amount of light to enter. 
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Moreover, you will notice that if the camera chooses 1/125 shutter speed and F8 as the aperture and you decide to 
increase shutter speed using that wheel selector and change it to 1/250 you will notice that the camera automatically 
changes the aperture to F4. That tells you immediately, once you think about it, that 1/125 @ F8 is really the same 
exposure as 1/250 @F4! The trade off is that F4 will give you a much more narrow depth-of-field compared to F8. 
On the other hand 1/250 shutter speed might make the difference between a blurred shot and a clean shot since the 
lower the shutter speed the more difficult it is to hand-hold a camera. 

Now let’s go back to flash and how the “P” setting affects the images you take. The following will assume that you 
are using the center focus point on your camera. Most DSLR’s have many focus points. Set yours to use only the 
center focus point for now. 

Remember above how the flash sends out a pre-flash? In the “P” mode, the camera and flash assume you want 
ONLY to expose the subject and nothing else around it including the background. (Remember the bold writing five 
paragraphs above). This is very important because let us take a situation where you are in the wedding reception 
hall, the lights are turned down, you take a photo of the bride and groom dancing and you are in “P” mode. You will 
get a great photo of the bride and groom but the background will be dark. Not that this is bad understand but what if 
you really wanted to light the background as well because about ten feet in back the bride and groom is the brides 
Mom and Dad? They will not be seen. 

At this point, you can “fix” this problem two ways. One is to go back to the icons mentioned above. Go to the icon 
that means “night portrait”. Take the photo again and suddenly the background is exposed. But there is a price to 
pay for that. The shutter speed is drastically reduced by the camera in that position. In fact, it may be so slow that 
the subjects will be blurred if they move. Shutter speeds may go as low as 1/10 second or perhaps 1/20 second…
much to slow without having your subject remain very still while you focus and take the shot. But you will light the 
background! 

Another Way – Shooting in Manual (M) Mode 
There is a better way. Every pro knows this. I want you to learn this. You simply put your camera on “M” for manual. 
Now, with the camera on “M”, you can set the shutter speed and lens opening (aperture) to wherever you desire. 
The desired and most widely used pro settings are a shutter speed of 1/60 and an aperture of F5.6. I use that one. 
You might also try 1/60 and aperture of F8. Suddenly, a whole new world of flash photography opens up to you. 
First, you will not be concerned if someone moves and secondly you will light the background. 

This is because in any programmed mode such as TV, AV or M, the camera takes good direction from you and as-
sumes you want the background lighted as well. This is built in by the bright engineers at the factory we talked 
about. 

But please do only try this in the manual mode. Once I enter the reception hall, I automatically set up my camera to 

“M”, 1/60 @ F5.6 and fire away all night. If I do want a shot with the background dark simply move the dial back to 

“P” mode and fire away. Nothing else needs to be adjusted. 

 

How to back up photos from your computer 
It is easy to think that photos on your computer or on a 
memory stick are safe, but there is always a chance of a 
fire, a robbery, you could lose it or it could just break. 
It is important to keep a back up of everything on your 
computer that would make you feel sick if you lost, wheth-
er that's important documents or photos. 
There are two main ways to do this: 

1. A portable hard drive, preferably kept in a different 
location 
A cloud back up system 

1. Using a portable hard drive 
Using a portable hard drive to back up your files is one of 
the simplest options.  Keep a copy of everything important 
on the separate drive and your files are safe if your com-
puter fails or is lost or stolen.  Keeping the hard drive in a 
different location also means that it will be safer during a 
robbery or fire. 
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The risk of this method is that you have to remember to back up your files yourself whenever you have 
something new your wouldn't want to lose.   
There is also of course the possibility that your hard drive itself will fail or get lost or stolen.  
For the best ways to back up either a PC or a MAC, have a read of this wikiHow Article.  
https://www.wikihow.com/Back-up-a-Computer 

2. A cloud back up system 
Backing up your photos 'in the cloud' means you are using an online service to keep your photos backed up 
on their servers.  You can set a schedule so that backing up is automatic, meaning once it's set up you can 
relax, knowing that the folders you have chosen will be backed up on the schedule you set until you say 
otherwise.  
This can sometimes be a little trickier to set up at first but if you put the time in now you'll have much sim-
pler backups for as long as you need them.  
For a good article on the best Cloud Back Up Systems, try this one from PC Magazine   http://
uk.pcmag.com/backup-products-1/8648/guide/the-best-online-backup-services-of-2018 

How do I back up my photos? 
All my work photos are transferred onto my computer straight after each Newborn Photo Shoot.  They are 
then copied onto a portable hard drive, which then automatically backs them up to Crash plan, a cloud back 
up service that I use.  
This way I have the original file, a copy on a separate hard drive and a version in the cloud.  
I'm also extra careful with my phone photos.  Every photo and video I take is backed up to both Google 
Photos and Dropbox. 
I hope this has helped you see just how important backing up your photos is and that it doesn't have to be as 
complicated as you think. 
It's so easy to think that your phone will never get stolen or your computer will never just give up the ghost, 
but it just might - and wouldn't you rather be safe in the knowledge that you photos and videos are safe if it 
does? 
Do your future self a favour and take 10 minutes today to back up your photos and save a whole lot of re-
gret when you lose all those memories in the future.  
 

 

Focus Stacking Tutorial for Landscape Photog-
raphy 
By Spencer Cox 48 Comments 
 
A lot of landscape photographers are interested in focus stacking — combining multiple images of the 
same scene, each focused at different distances, into a single photo. This is a useful tool to have at your dis-
posal, since it lets you take pictures in more situations than you otherwise could. For example, if elements 
of your photo are very close to your camera, focus stacking may be the only way to get a sharp shot. Alt-
hough I don’t use this technique for every photo, it’s something that I keep in mind when I’m taking pic-
tures in challenging conditions. This article gives an overview of focus stacking for landscape photography, 
including step-by-step instructions on how to focus stack photos in Photoshop. All of these tips are also 
relevant for other types of photography, not just landscapes. 

1) What Is Focus Stacking? 
Focus stacking is an interesting development of digital photography, and, more specifically, digital post-
processing. 
Focus stacking lets you take several photos of a landscape, focused at different points, and combine them 
together into the sharpest possible image. For example, you may take three photos at a particular scene: one 
focused on the foreground, another on the middle-ground, and a third on the background. Then, you can 
take the best parts of each photo and combine them into a fully-focused image. 

https://www.wikihow.com/Back-up-a-Computer
https://www.wikihow.com/Back-up-a-Computer
http://uk.pcmag.com/backup-products-1/8648/guide/the-best-online-backup-services-of-2018
http://uk.pcmag.com/backup-products-1/8648/guide/the-best-online-backup-services-of-2018
http://uk.pcmag.com/backup-products-1/8648/guide/the-best-online-backup-services-of-2018
https://photographylife.com/author/spencer
https://photographylife.com/landscapes/focus-stacking-tutorial-for-landscape-photography#comments
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(The latest 
installment in “Spencer can’t draw, but a diagram here would be useful.”) 
You can focus stack with any lens and camera, but you need to have the right post-processing software to 
combine the photos together. I use Photoshop, since that’s what I already own, but there are better pro-
grams out there if you do a lot of focus stacking — Helicon Focus and Zerene Stacker being the two main 
products. However, if you only do occasional focus stacking, Photoshop’s tools should be fine. 
2) Why Focus Stack? 
There are two main reasons why you might want to focus stack a landscape photo. 
First, you could be photographing a landscape that has too much depth. In other words, some parts of the 
scene are too close to your camera, and they’re out-of-focus if you shoot just a single photo. This can hap-
pen if your foreground is very close to your camera — there’s just no way to capture a focused foreground 
and background in one shot (even at small apertures like f/16). 
You’ll also run into sharpness problems when you use telephoto lenses for landscape photography. Be-
cause they have such a thin depth of field, telephoto lenses will cause some blurriness in all but the most 
distant landscapes. Again, even an aperture of f/16 may not give you enough depth of field. 
For me, that’s the most common time that I use focus stacking — when there’s no other way to get enough 
depth of field. In fact, I shoot most of my focus stacks at f/16, since it means that I don’t have to take as 
many photos (more on that later). 
However, there’s also a second reason why some photographers focus stack, and it’s equally valid. 
Because all lenses have a sweet spot, there will be an aperture that gives you the sharpest possible photo. 
For a lot of lenses, this sweet spot will be somewhere from f/4 to f/8. Unfortunately, those apertures don’t 
always give you enough depth of field, so you have to compromise. 
Or not — that’s the other reason to use focus stacking. If you want the absolute highest image quality of a 
given landscape, you can use your lens’s sharpest aperture and stack together as many shots as you need. 
The downside, of course, is that you need to take several photos per scene to capture all the depth of field. 
In the end, you should only focus stack if you require more detail than the camera can capture in a single 
photo. You might create huge prints, do a lot of cropping, or work with landscapes that have an unusually 
large depth of field. Regardless, focus stacking helps you get the last little bit of image quality that you 
can. 

3) When Can You Use Focus Stacking? 
Of course, nothing is a free ride. On one hand, compared to a single photo, focus stacking takes up more 
time and memory card space. Plus, not all landscapes even work for focus stacking. 
For example, think about a wave rolling into shore. It’s not a problem to take a single photo, but focus 
stacking is essentially impossible — the wave will move too much from frame to frame. This is true in 
many landscapes with fast-moving subjects. The more quickly a scene changes, the harder it is to focus 
stack. 
If the landscape isn’t moving too much, though, you can focus stack most of the time. Of course, this is 
only true if you’re willing to go through the effort of capturing multiple photos at once. The more often 
that you focus stack, the longer you need to spend working on every shot you take — both in the field and 
in post-processing. If you use focus stacking 100% of the time, you’ll run out of space on your memory 
card much faster than usual. 
That said, if you have to use focus stacking, it’s a great tool. Don’t avoid it just because it takes time; in 
the end, it’s worth the effort for certain scenes. So, how do you focus stack? That’s covered in the next 
section. 

https://photographylife.com/wp-content/uploads/2016/11/Focus-Stacking-Diagram.jpg
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4) How to Focus Stack Landscape Photos 
Focus stacking isn’t hard, but it definitely requires more effort than when you take single photos. 
To start, you need to employ best practices in the field. What does this mean? Quite simply, you have to 
take photos in a way that your stacking software can recognize easily. 
First, you should use a tripod. Although it’s possible to shoot handheld focus stacks, it will increase the 
likelihood of difficulties in post-processing. 
Second, make sure that you don’t change the focus too much from shot to shot. For example, if you only 
take two photos — one focused on the foreground, and one on the background — the middle of your photo 
could be blurry! Even if your post-processing software still blends the shots together, the final image won’t 
look very good. 
When you’re in the field, it’s best to focus on the exact spot in the prior image where sharpness first starts 
to decrease. You might need to zoom in on live-view in order to do this properly. By doing this, you avoid 
an unnatural-looking final result. 
Now that you’ve taken your photos, it’s time to start blending them! Here, I’ll demonstrate how to focus 
stack in Photoshop, since that’s the software you’re most likely to have. (If you have Zerene Stacker or 
Helicon Focus, you’ll have a bit more control over the process.) 
Before you open the photos in Photoshop, you need to make sure that they are ready to merge. 
Specifically, ensure that the brightness of all your photos is the same — otherwise, they won’t merge 
properly. Normally, this won’t be a problem, but you might notice a brightness difference if the light was 
changing quickly from shot to shot. 
The photo below(along with six other photos focused at different distances) is part of the focus stack that 
this article covers. I took these images at f/5.6, which makes it easier to see the thin depth of field: 

NIKON D800E + 
70-200mm f/4 @ 92mm, ISO 100, 1/8, f/5.6 
Here’s the focus stacked result (unedited — final version at the bottom of the article), where everything is 
incredibly sharp: 

https://photographylife.com/wp-content/uploads/2016/11/Blurry-Focus-Stack.jpg
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This is the unedited 
version of the final focus stack. You can see how much sharper it is than the prior photo — click on the 
two images if you want to compare them larger. 

5) Focus Stacking Checklist 
Now that you’ve taken your photos, it’s time to bring them into your post-processing software. Here’s a 
quick checklist that can help if you use Lightroom and Photoshop: 
First, open all of the images in Photoshop. You can do this by entering Lightroom, highlighting every shot, 
then clicking “Open as layers,” as shown below:

 
Once your photos are in Photoshop, select all the layers, and click Edit > Auto-Align Layers. In the next 
window, you can leave the blend mode to “Auto”:

https://photographylife.com/wp-content/uploads/2016/11/Focus-Stack-Unedited.jpg
https://photographylife.com/wp-content/uploads/2016/11/Focus-Stack-Screenshot-1-1.jpg
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Now, click Edit > Auto-Blend Layers, and then “Stack Images,” as below:

 

 
Click Layer > Flatten Image. Save the photo by clicking Control + S (Windows) or Command +S (Mac), or 
just File > Save. That sends the completed version back to Lightroom:

https://photographylife.com/wp-content/uploads/2016/11/Focus-Stack-Screenshot-2.jpg
https://photographylife.com/wp-content/uploads/2016/11/Focus-Stack-Screenshot-4.jpg
https://photographylife.com/wp-content/uploads/2016/11/Focus-Stack-Screenshot-3.jpg
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Open Lightroom again. Now, you need to crop the photo so it looks good. Often, the edges of your im-
age will have large sections that are extremely blurry — you need to crop those out. Here’s how that 
looked for this particular focus stack:

 
Finally, once you’re done cropping, just clean up the image and edit it however you want! There’s no 
wrong way to proceed from here. You’ve already created a focus-stacked image. 

6) Conclusion 
Although focus stacking isn’t something you should do all the time, it’s an important tool to have at your 
disposal. 
Sometimes, you may use a telephoto lens and have difficulties getting everything in-focus. Or, you could 
have a landscape that stretches so far that even f/16 doesn’t have enough depth of field. Finally, if you’re 
interested in nothing but the top sharpness, you might focus stack a landscape simply to use your lens’s 
sharpest aperture (like f/5.6 or f/8) rather than a smaller aperture which has diffraction. 
There is no right or wrong reason to focus stack, but be aware that you can take this technique to levels 
that might not be worth the effort. When I first learned about this focus stacking, I tried to use it on every 
landscape that I shot, simply to get the sharpest photos. Unfortunately, this meant that each photo took five 
times longer to capture! I ended up with sharp photos, but I didn’t get as much variety in my shots, and my 

https://photographylife.com/what-is-diffraction-in-photography
https://photographylife.com/wp-content/uploads/2016/11/Focus-Stack-Screenshot-5.jpg
https://photographylife.com/wp-content/uploads/2016/11/Focus-Stack-Screenshot-6.jpg
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work suffered as a result. Now, I’m more likely to use f/16 than to focus stack at f/5.6. If focus stacking 
works well for your personal style, though, that’s great — don’t let me discourage you. It just isn’t the case 
for everyone. 
Hopefully, this helped provide a good platform for you to start focus stacking your own shots! If you have-
n’t tried it before, give it a go. For certain difficult landscapes, focus stacking is an incredible tool. 

 
 

Looking for a free program to stack your photos with, then why not try the below softare. 

Sequator 
In a nutshell, Sequator is a free program that is meant to stack images of the night sky for the purpose of reducing 

noise.  Not only that, but Sequator is meant to also handle images with foregrounds, making it a tempting choice for 

landscape astrophotographers.  The program was made by software engineer Yi-Ruei Wu from Taiwan and is availa-

ble only for Windows.  The website for Sequator states that the program is meant to be “simple but powerful.”  That 

all sounds like good news, right?  Well, yes, it is good news, so that's probably why it sounds that way.  And there 

really isn’t any bad news to go with it, other than the fact that from what I can tell, the program has been around 

since at least 2015 and I just never knew about it… 

Final Thoughts 
Sequator is a pretty darn good free program.  While all of its features aren’t as useful as they could be, the main 
function—stacking landscape astro / photography images to reduce noise—is very effective.  It simplifies the process 
when compared to Photoshop, and provides good enough results that I will be looking to integrate it into my workflow 
in the future.  One thing to keep in mind is that I could not seem to get any basic edits I made to my RAW or DNG 
files to stick when being imported into Sequator.  So, if you want to make any kind of edits to your files before stack-
ing, you may have to export your RAWs or DNGs to a new file in order to get Sequator to see those edits.  One of 
the most noticeable results of this was the Sequator output files having slightly more color noise than the images 
stacked via Photoshop, which is most likely because Photoshop was benefiting from the standard Color Noise reduc-
tion applied by Lightroom upon import. 

For those who are interested, you can download Sequator here   https://sites.google.com/site/sequatorglobal/ 

 

https://sites.google.com/site/sequatorglobal/
https://sites.google.com/site/sequatorglobal/
https://photographylife.com/wp-content/uploads/2016/11/Spencer-Cox-Focus-Stack.jpg
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